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Abstract 
This whitepaper focuses on the use of ACT! by Sage Premium in a Microsoft® Terminal Server or Citrix 
Presentation Server™ environment. Please note that Citrix® compatibility is available in both ACT! by 
Sage and ACT! by Sage Premium. Setup for each is very similar and differs primarily around the 
feature set differences between ACT! and ACT! Premium. For the purpose of this white paper, we are 
using ACT! Premium as the example; when ACT! is used for brevity, it refers to ACT! Premium.  
The white paper explores the benefits of deploying ACT! Premium through Terminal Services, outlines 
deployment requirements and recommendations, and provides installation and performance tips. It is 
intended for IT Administrators who are considering deployment of ACT! using Microsoft Terminal 
Services, with or without Citrix.  
 
Does ACT! run on Citrix? The answer is an emphatic YES, when properly installed, configured and 
deployed on servers with sufficient resources. With very few exceptions, the features of ACT! Premium 
are available on Citrix. 
 
Features not supported: Integration with a fax is supported via normal fax integration on Windows® 

2003 (i.e., the fax looks like a printer). Integration with an automatic dialer is not supported. 

Introduction 
ACT! Premium is a robust, feature-rich solution that provides centralized contact and customer 
management. Powerful features include: fast access to all relevant Notes, History, and Activities  
associated with individual Contacts, Groups, Opportunities, and Companies. Additionally, ACT! 
integrates with—and adds value to—tools used every day, such as Microsoft Office.  
 
Many companies with remote employees use Terminal Services with Citrix to deploy applications and 
want to deploy ACT! in the same manner. By implementing ACT! centrally on one or more Microsoft 
Terminal Servers with Citrix1, an organization can reap the benefits of centralized deployment and 
maintenance, as well as anytime, anywhere access. ACT! can be installed on Microsoft Terminal 
Servers with or without Citrix.  1 Citrix and Terminal Services require 

specific configurations. Citrix is supported 

using Presentation Server V3.0, V4.0, 

and V4.5. Microsoft Terminal Services is 

an optional component of Windows 

Server 2003. Terminal Services allows for 

multiple, remote user logins using the 

Microsoft RDP protocol. Citrix installs 

over and builds on Terminal Services with 

additional functionality using the ICA 

protocol included with Citrix Presentation 

Server. Basic Terminal Services and 

Citrix value-add are not covered in this 

paper. For specific information on these 

products please see the Microsoft or 

Citrix Web sites. 

 
Although there are some small differences in deployment of ACT! if Citrix is used, the differences are 
the same for any application deployed on a Terminal Server. In this whitepaper, statements regarding 
the use of Citrix also apply to the use of Terminal Services without Citrix, unless a difference is 
explicitly stated.  

Deployment Options 
The following sections compare the traditional ACT! Premium desktop deployment and a simple 
deployment using Terminal Services and/or Citrix. Also outlined are the organizational benefits of 
deployment using Terminal Services and/or Citrix.  

Desktop Deployment of ACT! Premium 
In a desktop deployment, ACT! (and any software that ACT! will integrate with, such as Microsoft 
Office), is installed locally on each user’s computer. The database is often centralized, typically using 
Microsoft SQL Server®, allowing the group to share contact information.  
 
Each user has a personal login. This personal account allows individual e-mail and scheduling and 
permits the software to track activities associated with a contact to the individual user. 
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Figure 1 - Desktop Deployment without Terminal Services or Citrix 
 

To simplify remote 
deployments, provide 
administration flexibility, 
and increase security, 
companies often look to 
deploy ACT! through 
Terminal Services and/or 
Citrix. 

As with any installed application, each computer with ACT! needs to be individually and physically 
managed for installation, set-up, and maintenance (other than that which can be handled through the 
database). This is manageable in small deployments, but becomes more challenging with larger user 
counts, greater computer variety, and remote users. For remote users, the ACT! Premium database is 
often centralized with secure access through a Virtual Private Network (VPN). Remote ACT! users can 
choose real-time database access or periodic synchronization. To simplify remote deployments, 
provide administration flexibility, and increase security, companies often look to deploy ACT! through 
Terminal Services and/or Citrix.  

Simple Deployment using Terminal Services and/or Citrix 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2 A deployment using native Terminal 

Services without Citrix is logically the 

same. 

Figure 2 - Simple Citrix2 Deployment 
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In this deployment, ACT! (and the software it integrates with) is installed once – on the Citrix Server3. 
The only software needed on the end user’s computer is a Citrix ICA client and, optionally, a Web 
browser4.  
 
The administrator performs additional setup activities on the Citrix Server for each user of ACT!; this is 
faster than installing and configuring each computer. All maintenance activity is also centralized – so 
the administrator no longer has to visit the users’ desks. Tools that come with Citrix, such as session 
shadowing, allow the administrator to view and/or take control of a user session. This dramatically 
increases both user and administrator productivity. 

Benefits of Deploying ACT! Premium Using Terminal Services and/or Citrix Using Terminal Services 
and/or Citrix, ACT! can be 
made available on 
computers other than 
Windows PCs, including 
thin clients, Macintosh, 
Linux PCs, or any device 
with an RDP or ICA client. 

Deploying ACT! using Terminal Services and/or Citrix has advantages for both users and 
administrators. 
 
Benefits to Users:  
 

• No need to install, configure, or manage ACT! on user computers. All set-up and 
administration is performed by others. 

• In addition to Windows PCs, ACT! can be available from a range of computers including 
Macintosh®, Linux PCs, thin clients, etc. 

• Anytime, anywhere access to ACT!. 
• Due to low bandwidth requirements, ACT! users may experience improved performance on 

less robust hardware. The same is true for remote users on a high latency WAN. 
 

 
ACT! Premium Licensing on      

Terminal Servers and/or Citrix 
 

Although only one copy of ACT! is 
installed, each user connecting to ACT! 

needs a valid license count in ACT!. 
Therefore, the serial number installed 

and activated in ACT! must have 
sufficient licenses to accommodate all 

users accessing ACT! via Citrix. 

 
 
 
 
 
 
 
 
 
 
 
 

Benefits to Administrators:  

• Central installation and maintenance of the ACT! application and database. 
• ACT! deployed as part of a published desktop or published application (Citrix). 3 The SQL Server  Database can be 

installed on the Citrix Terminal Server. 

 

4 If native Terminal Services is used 

without Citrix, then the Microsoft Remote 

Desktop Connection Client is needed. 

This is part of Windows XP, but can be 

downloaded for older operating systems. 

• Easily “shadow” ACT! users for troubleshooting and/or training. 
• Enhanced ACT! security using SSL and strong authentication methods. 
• Better ACT! performance from a range of different machines, network topologies, and 

network latency. 
• ACT! deployment and administration consistent with other applications. 

 
Using Terminal Services and/or Citrix, ACT! can be made available on computers other than Windows 
PCs, including thin clients, Macintosh®, Linux PCs, or any device with an RDP or ICA client. Users 
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also benefit from increased ACT! access, since deploying ACT! on the Terminal Server allows user 
access from any computer. This includes computers elsewhere in the building or outside the office. 
ACT! users can work from home on their personal computers, on the road in a hotel, at an Internet 
café, or wherever Wi-Fi is available, without having to install software.  
 
When deployed using Terminal Services and/or Citrix, the memory and CPU requirements on 
individual user desktops and notebooks are significantly reduced. On the Terminal Server, each user 
is running a copy of ACT!. While the Terminal Server will be a more robust computer than a typical 
desktop PC, adding more users erodes a single server’s ability to sustain desired performance. As 
user counts increase, multiple servers can be deployed, as shown in Figure 3. Adding additional 
servers and leveraging built-in load balancing make it easy to add additional users and/or enhance 
performance levels. Please note that due to the resource requirements of a robust application like 
ACT!, administrators should carefully monitor the number of users per Terminal Server and adjust the 
number of concurrent users per server to align with performance requirements. 
 
 
 
 

When ACT! is deployed 
using Terminal Services 
and/or Citrix, the memory 
and CPU requirements on 
individual user desktops 
and notebooks are 
significantly reduced. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 3 - Multiple Citrix Servers and Remote Access 
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Load Balancing 
Deploying ACT! using 
Terminal Services/Citrix 
provides secure, remote 
access to critical contact 
and customer information. 

While individual users may be assigned to specific servers, it is more common to use a load balancer. 
For ACT!, DNS round-robin load balancing (such as Windows Network Load Balancer, which often is 
used in a Web farm) is sufficient. Citrix also has a load balancer that can be used to monitor the 
number of concurrent sessions and optimally assign user connections. This is often superior to DNS 
because it is more intelligent in how it determines which server to access. When users might be 
assigned to different servers by a load balancer, Roaming Profiles are typically used so that user-
specific settings5 follow the user, no matter which server they are connected to.  
 

Note: Load balancing and roaming profiles are not covered further in this White Paper 
because there is nothing specific about deploying ACT! with these components that is 
different than for any other application. However, they are an important part of deployment 
considerations. 

 

Secure Remote Access 
Secure remote access to ACT! data is a critical requirement for the user, administrator, and company. 
There are several options to choose from. A VPN access solution for remote users is one option. 
Typically, the VPN device exists in an organization’s network Demilitarized Zone (DMZ), between the 
outside and inside firewalls. Citrix offers two additional options: the Citrix Secure Gateway (CSG) and 
the Citrix Access Gateway (CAG). 
 

• CSG is software added to a Microsoft-based server placed within the DMZ. Remote users 
access the CSG via a Web browser using Secured Sockets Layer (SSL). Once users 
authenticate within the DMZ, they are granted access to the Citrix Servers inside the firewall. 

• CAG is dedicated hardware that acts as a hardened SSL/VPN appliance for use in the DMZ. 
This provides a more secure access solution.  

 
Though not shown in the deployment illustrations, these products are transparent from within ACT! 
and are recommended for their security benefits. 
 
Customers without VPN access via Citrix may use an existing VPN (Cisco® or others) for remote 
access through the firewall. Directly exposing the Microsoft Terminal Server RDP (port 3389) or Citrix 
ICA (port 1494 or 2598) ports to the outside world is not recommended because of the likelihood of 
attacks against them. Some enterprises that expose RDP or ICA protocols directly (rather than 
through SSL) renumber these ports, but port scanners can still find them. More information on 
securing the access is available from Microsoft and Citrix, as well as many Terminal Server-oriented 
Web sites. 
 
 

System Requirements 
The minimum system requirements for ACT! Premium are all that is required for using ACT! in a Citrix 
environment. ACT! Premium system requirements can be found at www.act.com/2010systreq. For 
Citrix Presentation Server system requirements, check with your Citrix representative. 

5 For example, this includes the user’s 

“My Documents” folder, application 

shortcuts, and registry settings affecting 

user-specific application customizations. 
In planning the system, the administrator should consider ACT! as a substantial platform to be added 
to the server(s), since users typically leave ACT! open all day long. 
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Additional Notes When Considering System Requirements:  
• Turning on HyperThreading may yield about 1.8 processor equivalents for ACT! 

(recommended administrators only enable on Windows 2003 systems). 
• Two separate drives are preferable to a single drive. This is often referred to as “two 

spindles.” When using two drives, install OS/page file on the first drive, and install ACT! and 
its database on the second drive.  

• The initial database file of 20 MB is included in this number. Administrators should also 
consider the amount of additional disk space to reserve to accommodate growth. Additional 
disk space for growth of the database should also be considered. (Keep in mind that if ACT! 
internal e-mail software is used, those e-mails will be stored in the database.) 

• ACT! Premium installation requires 1000 MB of disk space. Most of this space is used in the 
installation folder selected by the installer; however, a sizable portion is installed in the 
Windows GAC (Global Assembly Cache). Each ACT! user will require an additional 30 MB in 
their profile folder. 

 
At runtime, each concurrently logged in ACT! user will use 80-95 MB of memory for ACT! itself. If the 
ACT! internal e-mail is used, the user will require an additional 15-20 MB. If the server has insufficient 
memory resources, user scalability6 is impacted. 
 
ACT! uses significant CPU resources as well. When the user has ACT! open but is not actively 
working with it, the CPU resources are minimal. When actively using ACT!, the user will consume 
significant CPU resources in short bursts. The activity level of the users will limit the scalability7 on the 
Terminal Server. 
 
 

6 Scalability will vary based on hardware 

and size and usage of your database. 

Published minimum system requirements 

found at www.act.com/2010systreq are 

based on single user environments. You 

must purchase one license of ACT! per 

user. 

 

7 Scalability will vary based on hardware 

and size and usage of your database. 

Published minimum system requirements 

found at www.act.com/2010systreq are 

based on single user environments. You 

must purchase one license of ACT! per 

user. 

 

8 See www.act.com/2010systreq for 

Service Pack and other requirements, 

such as for Microsoft .NET Framework. 

Installing ACT! Using Terminal Services and/or Citrix  
This section provides guidance to an administrator who is installing ACT! on a Terminal Server and/or 
Citrix. Consult the ACT! Installation Guide for the most current information on installing ACT!. 

The administrator installs ACT! and related software in this order: 

1. Install Terminal Services and/or Citrix on the server8.  
2. Install any software that ACT! integrates with, such as Microsoft Outlook® and Word. 
3. Install ACT! Premium.  

 
The administrator performs all installation activities with the Terminal Server in “install mode.” The 
recommended method to install ACT! in a Terminal Server and/or Citrix setting is listed on the next 
page. 
 
 
 
 
 
 
 
 

http://www.act.com/2010
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Order Action Where Taken 

1 Installing the database server 
software  

On the PC that will house the database 

2 Installing ACT!  On each server that will house ACT! users 
via Citrix or Terminal Server 

3 Activating and registering ACT! 

4 Performing site-specific 
customizations 

5 Deploying ACT! for multi-user access 

6 Publishing ACT! as a Citrix-published 
application 

Once, from any machine with the Citrix 
Management Console installed 

7 Initializing individual user setups For each user (with roaming profiles, this 
can be done on any Terminal Server and/or 
Citrix) 

Using Terminal Services 
and/or Citrix, the 
performance requirements 
of the user’s client machine 
are reduced, since the only 
software running on the 
client is a browser and/or 
ICA/RDP client. 

The following sections provide details for each step in the chart above. 
 
Step 1: Installing the Database Server Software 
The ACT! installer guides you through the installation of the components necessary, including SQL 
Server, the Service Pack, and the hot fix, and through the creation of the ACT! database. You install 
the software only on the machine that will host the database. 
Do the following: 

 
Note: You must be a System Administrator to perform this installation and use the “Change 
user/install” command before installation.  
 

1. If you have installed or uninstalled any version of SQL Server (including SQL Server 
Express) from the server, reboot the server before starting this installation.  

2. First, install the database. Follow the instructions on screen. Be patient, as progress in some 
cases is not evident for some time.  

3. Reboot the system after installation is complete. 
 
The DVD installs SQL Server and the Service Packs, and it creates and starts the ACT! instance. It 
also installs a file that users utilize to access the database. This file, called a PAD file, needs to be 
accessible to ACT! users. When the database is on a separate machine, the PAD file is usually made 
available via a shared folder or mapped drive. 
 

4. Make the PAD file available (read-only) to all users, via a shared folder or mapped drive. 
 
Step 2: Installing ACT! 
Once the database is in place (and the system has been rebooted), you can install ACT! program files 
on the Terminal Servers. The basic installation, allowing the Administrator to run ACT!, is simple.  
 
Do the following: 

1. Log on to the server as an Administrator. 
2. Change user/install. 
3. Launch the installer. 
4. Follow the instructions. 
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5. Near the end of the installation is an option to launch ACT!. Because the server is in install 
mode, do not select this option. 

6. After installation is complete, Change user/execute. 
 
Step 3: Activating and Registering ACT! 
The Administrator starts ACT! to obtain any available updates from the Web, set standard 
preferences, and create the database. 
 
Each user requires access to the database file. By default, ACT! suggests a location for the PAD file in 
the profile of the user who creates the database. In the Terminal Server environment, this location 
should be overridden. 
 

• In a single Terminal Server environment, a new subfolder in the install folder may be 
appropriate, or the administrator may choose another location.  

• If multiple, load-balanced, Terminal Servers are in use, a single machine should be 
responsible for hosting the database files, and it should be made available via a mounted 
share. Select the option to “Share this database with other users” when creating the 
database; the folder selected for the database will be mounted for you as a share. Default 
permissions for this share are Read/Write for “Everyone”, since ACT! users need full access 
to this folder. Share this folder only if multiple servers are used, not if multiple users access 
one server. 

 
Do the following: 

1. Log on as an Administrator to the server that has ACT! installed and that will house the 
database. 

2. Change user/install. 
3. Create any folders or mapping needed for the database. 
4. Launch ACT!. 
5. When prompted to check for updates, click Yes. Follow the instructions that appear. 
6. When the Registration and Activation Wizard appears, follow the instructions. 
7. When the Getting Started Wizard appears: 

 
• Step 1: Selecting the “In the future, hide this page” option only affects this user. Click 

Next. 
• Step 2: Select a word processor (ACT! or other, if detected), and then click Next. 
• Step 3: Select Skip e-mail Setup, and then click Next (if the administrator is not a 

regular user of ACT!). 
• Step 4: If a database has not been created, select Create new database, and then click 

Next. 
• Step 5: Select a database name. Change the location to the shared folder where the 

database file will reside. Select the Share this database with other users checkbox.  
• Enter a user name and password, and then click Next.  

o Note: This is a user name and password for this Administrator to open the 
ACT! database. This name/password will have full Administrator rights to the 
database. 

• Step 6: Click Finish. 
8. ACT! opens. You may be prompted to import Outlook contacts, even if e-mail was not set up, 

and Outlook is not installed. Click No (if the Administrator does not normally use ACT! from 
this account). 
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9. If user teams are desired, from the menu bar, select Tools > Manage Teams. For each ACT! 
team, select Create Team. 

10. From the menu bar, select Tools > Manage Users. For each ACT! user licensed, select 
Create New User. 

11. Continue with any other site/tenant-specific customizations (such as in Tools > Preferences). 
12. Exit ACT!. 
13. Change user/execute. 
14. On additional servers, follow the same steps, except in step 4, skip database creation and 

open the shared database mounted from another server via the “PAD” file. 
 
 
Step 4: Performing Site-Specific Customizations 
ACT! can be customized by end users. Generally, these customizations are stored in XML-formatted 
files under the user profile folder. The preferred method of customization is to use ACT! to modify 
these preferences. The Administrator should make company-specific customizations before deploying 
to users (see “Multi-User Deployment,” which follows this section).  
 
Do the following: 

1. Log on as the Administrator who installed the software. 
2. Change user/execute. 
3. Launch ACT!. 
4. Change settings and preferences as desired. These settings should be site-specific, not 

user-specific. Although these settings will be the default, users can override them. 
5. Exit ACT!. 

 
Step 5: Deploying for Multi-User 
The Administrator needs to copy shortcuts and files from the Administrator’s profile to the All Users 
profile. After this is done, when users run ACT! and change their profiles, the changed files are copied 
to the users’ profiles. The ACT! XML files are stored in an ACT! folder in the user’s hidden “Application 
Data” folder.  
 

Note: After deploying ACT! to multiple users, the Administrator could make company-wide 
customizations by manually editing the XML files for each user. If users have not modified 
their profiles, the Administrator can manually edit the file copy in the All Users profile. 

 
Do the following: 

1. Log on as a system administrator. 
2. Open Windows Explorer.  

Note: You must be able to view hidden files and folders. To set this option, in 
Windows Explorer: Tools > Folder Options > View Tab. 

3. For a full desktop deployment: 
 

• In the folder: C:\Documents and Settings\All users\Start Menu\Programs\ACT! Premium, 
remove the Uninstall shortcut and any others desired. 

 
Note: If only a subset of the server users will use ACT!, you might want to remove all 
the shortcut entries from the All users start menu. 

 
• Browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. 
• If desired, delete the Service Manager shortcut. This puts an SQL Server manager 
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shortcut into the tray icon area of the desktop, which is probably not appropriate for 
most users. 
 
Note: The desktop shortcut to ACT! is only added to the desktop of the user that did the 
installation. For a full desktop deployment, you might move that shortcut to the All Users 
desktop instead. 
 

4. Go to the C:\Documents and Settings\All Users\Application Data\ folder. Copy the ACT! 
folder from the Administrator’s account (C:\Documents and Settings\name-of-administrator\ 

 
Step 6: Publishing ACT! as a Citrix-Published Application 
This step is taken once ACT! is installed on all servers in a farm or silo. 
 
In a Citrix installation, some enterprises use published applications rather than published desktops. 
The administrator can add ACT! as a published application as described in the following procedure. 
(The procedure example uses Citrix Presentation Server 4.5, however, the steps are similar for other 
Citrix versions.) 
 
Do the following: 

1. Start the Citrix Management Console and log on to the farm. 
2. Right-click on Applications, and then select Publish Application. 
3. Enter Display Name and a description (“ACT!”). 
4. For the Application Type, select Application. Browse for the command line, selecting 

ACT8.exe from the installation folder (generally, under Program Files). Click Next. 
5. Specify servers: Add each server ACT! was installed on. 
6. Specify users: Because personalization files are stored in each user’s profile, do not select 

Allow Anonymous Connections. 
 
Web Browser Redirection7, if used, will work for online Help and requests for maps. Product 
registration and updates require the use of the browser on the server. 
 
Step 7: Initializing Individual User Setups 
For integration with e-mail, the Administrator can: 

• Log on as each user to perform per-user customizations; or•  
• Provide information to users and ask them to perform these steps.•  

Setting up e-mail integration can be done either by using the Setup Assistant or through Preferences 
(Tools > Preferences > Email Tab > Email System Setup). For the purposes of this whitepaper, we 
have documented setup using the Setup Assistant.  
 
Integration with Internet Mail 
The Internet Mail feature of ACT! is an e-mail client that stores mail in a single e-mail database that all 
users share. This client uses folders much like Outlook does and is capable of handling all user e-mail 
needs. The client integrates with SMTP/POP3 servers to deliver and receive e-mail. The e-mail 
address for the SMTP server should be set up before performing this step. 
 

1. Launch ACT! as a user. 
2. The upgrade option appears. Ignore. 
3. The register option appears if the application has not been registered. This is another item 

the Administrator can move to the console. Ignore. 
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4. Getting started appears (even though we checked it before). Select the checkbox In the 
future, hide this page, and then click Next. 

5. Select the appropriate word processor. Click Next. 
6. Select Set up e-mail, Internet Mail. Click Next. 
7. Select Default Account: Enter the user name for the e-mail account, and then click Next. 
8. On the User Information tab, fill in the Account name and other fields, as appropriate. Also fill 

in information on other tabs, as appropriate. Test the account connection, and then click OK. 
9. Click Next twice. 
10. Database Setup: Select Skip database setup. Click Next. 
11. Click Finish. 
12. Select Open Database, and then select the PAD file in the shared folder. 
13. Enter the user name and password, and then click OK. 
14. In the Contact Detail view for the user, enter the e-mail address. 
15. Exit ACT!. 

 
Repeat these steps for each user. 
 
Integration with other e-mail programs 
Integration with other e-mail programs, such as Outlook or Outlook Express, follows the same strategy 
as for the ACT! Internet Mail. Simply complete steps 1-5. In Step 6, instead of selecting Internet Mail, 
select the supported ACT! e-mail program you want to integrate with and follow the Wizard from there.  
 
Multi-Tenancy Setup 
Multi-Tenancy refers to an Application Service Provider (ASP), where multiple, independent customers 
are supported by the same server. It also applies to an Enterprise where distinct groups want to use 
different databases. There are set-up issues to consider for multi-tenancy. 
 
ACT! can work in a multi-tenant setup if self-provisioning is not a desired feature. Each tenant will 
have a unique database. The Administrator should create each database in a different folder and put 
appropriate Access Control List (ACL) protections in place to prevent other tenants from accessing 
them.  
 
With Multi-Tenancy, the Administrator does not copy files into the All Users profile. The easiest 
approach is for the Administrator to use a different Windows administrator account for each tenant.  
The Administrator logs into each Windows administrator account and completes the steps under 
Deploying for Multi-Users, except for copying the ACT! folder into the All Users folder. Instead, the 
Administrator copies these files into each user’s profile for that tenant. 
 

Summary 
ACT! Premium can be effectively deployed using Microsoft Terminal Services and Citrix. There are 
numerous benefits:  

• Lower maintenance costs resulting from component centralization. ACT! components are 
installed centrally on a few servers. The ACT! Administrator no longer has to go to individual 
computers to perform maintenance tasks. 

• Secure remote access for those on the road. This configuration provides access to the data 
without it ever leaving the building or campus. ACT! users can access the data wherever 
they are as long as they have an active network connection. 
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• Fewer ports exposed through the firewall. 
• Typically, less WAN traffic for a remote user than with a traditional remote desktop 

installation with VPN access. 
• ACT! can be deployed to a user base of various computers such as Macintosh, thin clients, 

Linux PCs, etc. 
• Performance requirements of the user’s client machine are reduced since the only software 

running on the client is a browser and/or ICA/RDP client. 
• Enhanced training opportunities that allow an Administrator to “shadow” a user’s session to 

either walk the user through using the software or take control of the session and perform a 
task. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Important Note: Review ACT! system requirements at www.act.com/2010systreq. You must purchase one license 

of ACT! per user. Scalability varies based on hardware, size, and usage of your database. Compatibility: Due to 

new functionality available in ACT! 2010, we strongly recommend contacting your add-on product provider to 

confirm compatibility. Using versions of the add-on product that have not been confirmed compatible by the vendor 

may result in features behaving differently or not appearing within ACT! 2010. Visit www.actsolutions.com or contact 

your add-on product provider to help determine compatibility. 

http://www.act.com/2010systreq
http://www.actsolutions.com/
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Appendix: Knowledgebase Articles  
Knowledgebase articles related to ACT! deployment on Citrix or Terminal Services. 
 

ACT! Version  Knowledgebase  Knowledgebase Article 
Title 

Comments 

ACT! by Sage 2010 
& 2009 Solutions 
Family 

24086 How to Integrate ACT! 
by Sage and Microsoft® 
Outlook® in the Citrix® 
Environment 

 

ACT! by Sage 2010, 
2009, 2008, 2007, & 
2006 Solutions 
Family 

18046 Cannot Attach a Web 
Page to ACT! Contacts 
in a Citrix Environment 

 

ACT! by Sage 2010, 
2009, 2008, 2007, & 
2006  Solutions 
Family 

15275 Using ACT! with Citrix or 
Terminal Server 

Inquire with Citrix 
regarding Citrix 
system 
requirements 

ACT! by Sage 2006 
Solutions Family 

17444 How to Download and 
Apply the Citrix E-mail 
Hotfix 

 

ACT! by Sage 2006 
Solutions Family 

17449 Unable to Attach E-mails 
to Contacts When Using 
ACT! in a Multi-User 
Citrix Environment 

 

ACT! by Sage 2006 
Solutions Family 

17446 You See Another ACT! 
Users E-mail Inbox 

 

ACT! by Sage 2006 
Solutions Family 

17447 You See Another Users 
Signature When Using 
ACT! E-mail 

 

ACT! by Sage 2006 
Solutions Family 

17448 You See Another Users 
Address Book When 
Using ACT! E-mail 

 

ACT! by Sage 2006 
Solutions Family 

18061 Mail Merge Fields From 
Another Database are 
Available to Add to Your 
Template 

 

ACT! by Sage 2006 
Solutions Family 

17450 You See Another ACT! 
Users Contact List When 
Attempting to Attach an 
E-mail 

 

ACT! by Sage 2006 
Solutions Family 

16493 Only One User Can 
Open ACT! When Using 
Through Terminal 
Services 
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Microsoft® Terminal Server and Citrix Presentation Server™ Deployment Environments 16

ACT! by Sage 2006 
Solutions Family 

16761 Multiple ACT! Processes 
Create in Terminal 
Server/Citrix 
Environment 

 

ACT! by Sage 2006 
Solutions Family 

18405 When More Then One 
User is Connected via 
Citrix to ACT! User is 
Unable to Create New 
Database 

 

ACT! by Sage 2006 
Solutions Family 

17973 Export to Excel® Not 
Active and Cannot 
Select Microsoft Word 
as the Default Word 
Processor When Using 
the Database Through 
Terminal Services 

 

ACT! by Sage 2006 
Solutions Family 

16688 Error: “Exception has 
been thrown by the 
Target of an Invocation.” 
Or “Error Number: 
0x80040000” When 
Installing ACT! Link for 
QuickBooks®. 

Only local 
installations of the 
ACT! Link for 
QuickBooks 
application are 
supported. 

ACT! by Sage 2006 
Solutions Family 

16687 Error: “Failure to 
configure server” When 
Attempting to Install SQL 
Server 2000 or MSDE 

This error will result 
if you attempt to 
install SQL Server 
2000 or MSDE 
across a network 
connection or on 
any machine using 
a remote desktop 
application, 
including Citrix or 
Terminal Services.  
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 About ACT! 
ACT! by Sage is the #1 selling contact and customer manager in the world with 2.8 million users. It’s designed so you can organize all the details of your 
customer relationships in one place for a complete view of the people you do business with. Improve your marketing effectiveness to attract new 
customers and get more from existing relationships. And, take action on your most qualified sales leads with total visibility and control of your pipeline. 
Because ACT! is easy to learn and use, you can be more productive right away. Continue working with your existing business solutions, like Microsoft 
Outlook, Word, Excel, and Lotus Notes, because they integrate with ACT!.  
 
About Sage CRM Solutions 
Sage CRM Solutions is a portfolio of market-leading applications consisting of ACT! by Sage, Sage CRM, and Sage SalesLogix. Over 63,500 
organizations and 3.1 million users worldwide rely on Sage CRM Solutions to develop profitable, long-term business relationships. 
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All other trademarks are the property of their respective owners. 
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+ 86 21 63850097 
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www.MonAct.fr 
 
GERMANY 
Emil-von-Behring Str. 8-14 
60439 Frankfurt am Main 
Germany 
+49 69 50007 6260 
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Poland 
+48224555600 
www.actsage.pl 
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Softline Technology Park 
102 Western Services Road 
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Johannesburg, 2191 
South Africa 
+2711 304 3000 
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España 
+34 91 334 92 92 
www.sagecrm.es 
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